MICROCHIP ATSAMR30M
ATSAMR30M Sensor Board User's Guide

Introduction

The ATSAMR30M Sensor Board (DT100130) is a hardware platform used to evaluate the performance of the
ATSAMR30M18A (Sub-1 GHz IEEE® 802.15.4™ compliant) RF module. The sensor board provides easy access to
various ready-to-use applications supported by the ATSAMR30M18A module in the Atmel Studio Integrated
Development Platform (IDP). This document describes how to get started with the sensor board and how to integrate
the module in a custom design. The sensor board provides 802.15.4 wireless functionality to the mikroBUS™
compatible Clicker Board evaluation platform in the 800/900 MHz ISM band.

Features

ATSAMR30M18A Module is an IEEE 802.15.4 Compliant Wireless Module for 700/800/900 MHz(") Applications
— ATSAMR30E18A (ARM® Cortex® -M0+) System-in-a-Package (SiP)
— Single-ended RF output through the PCB castellated pad
— Radio module with a link budget
+ RX sensitivity up to -105(2) dBm
+  TX output power up to 8.7 dBm
— High precision 16 MHz crystal oscillator
* On-board PCB Antenna
» On-board AT30TSE758A Digital Temperature Sensor
— Integrated temperature sensor, non-volatile registers and serial EEPROM
— 2-wire 12C and SMBus compatible serial interface
+ Footprint Provision for Evaluating CryptoAuthentication™ Device (A\TECCG08A/ATECC508A)
* Power Supply Options
— Battery holder for a standard 3V CR2450 coin/button cell battery
— Header (J5) for external supply
— Clicker receptacle (J1) for supply from a Click board
» Serial Wire Debug (SWD) Header
» Digital /0
— Clicker receptacles comprising SPI, 12C and UART interfaces of ATSAMR30M18A
— One RESET button and one user button
— One user LED
» Supports Performance Analyzer Example Application in Atmel Studio

» Operating Temperature Range: -40°C to +85°C
Notes:

1. The PCB antenna supports only the 868-928 MHz band.
2. When fgg = 868.3 MHz, BPSK-20.
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Quick References

Reference Documentation
For further study, refer to the following:
» ATSAMR30M Sensor Board Product Page

*  ATSAMR30M Sensor Board Design Documentation Package containing Schematics, BOM, Assembly drawings,
3D plots, PCB Layer plots and so on

*  SAMR30 Module Xplained Pro User's Guide
+ SAMR30 IEEE® 802.15.4™ Sub-1GHz Module Datasheet
» IEEE 802.15.4 Sub-GHz System-in-Package Datasheet

» AT86RF212B Low Power, 700/800/900MHz Transceiver for ZigBee, IEEE 802.15.4, 6LoWPAN, and ISM
Applications Data Sheet

* 9-to 12-bit Selectable, +0.5°C Accurate Digital Temperature Sensor with Nonvolatile Registers and Serial
EEPROM Datasheet

+ CryptoAuthentication™ Device Summary Datasheet

Software Prerequisites
* Atmel Studio 7.0
*  Wireless Composer 7.0

Hardware Prerequisites
* ATSAMR30M Sensor Board Evaluation Kit
+ Atmel-ICE basic kit (ATATMEL-ICE-BASIC)
» USB to UART converter or mikroBUS FTDI Click Board
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ATSAMR30M

Kit Overview

2. Kit Overview

The ATSAMR30M Sensor Board is a hardware platform used to evaluate the ATSAMR30M18A module in the
mikroBUS compatible Clicker evaluation platform. This evaluation kit supports the Standalone mode, using a CR2450

battery or an external supply.
Figure 2-1. ATSAMR30M Sensor Board

LDO Selection/Bypass Jumper (J4)

External Supply Header (J5)
qunan

LI
. : Clicker Header (J1)
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PCB Antenna
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<+— Reset Button

] Crypto Device
] «— User Button

Temperature Sensor
Clicker Header (J2)
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Hardware Specifications

This chapter describes the hardware features and a range of peripheral components of the ATSAMR30M Sensor
Board.

Battery Holder

A 3V coin cell battery can be used to power-up the board using the battery holder (BT1) in the Standalone mode (for
example, battery powered wireless sensor node). The positive terminal of the holder is marked with a ‘+’ symbol on
top of it.

LED

The red color user LED (D1) is available on the board. The ATSAMR30M18A module can control this LED by driving
the connected I/O line to GND to activate the LED. There is no power indication LED available on the board.

Table 3-1. LED Functions

PA27 Red LED (D1) control

Mechanical Buttons

The ATSAMR30M Sensor Board contains two mechanical buttons:
* Reset button (RS_BTN) connected to the ATSAMR30M Reset line
— When the RS_BTN button is pressed, the Reset line is driven to ground, which resets the module
» Generic user-configurable button (USR_BTN)
— When the USR_BTN button is pressed, the 1/O line is driven to ground

Note: The PA28 pin connected with USR_BTN can be used as a wake-up source from the Backup mode of the
ATSAMR30M Sensor Board.

Table 3-2. Mechanical Button Functions

RESET RST_BTN Reset switch

PA28 USR_BTN User switch

Temperature Sensor

The ATSAMR30M Sensor Board has an on-board digital temperature sensor (AT30TSE758A). This sensor is
interfaced with the ATSAMR30M through I2C bus and is available on I12C slave address 0x48 (7-bit MSb address).
The AT30TSE758A also has a serial EEPROM, which is accessible through the same I2C bus with the slave address
as 0x50 (7-bit MSb address).

Table 3-3. Temperature Sensor Functions

Pin on ATSAMR30M m Shared Functionality

PAOS 12C Serial Data (12C SDA) ATECC608A and J2 pin 6
PA09 12C Serial Clock (12C SCL) ATECC608A and J2 pin 5

© 2020 Microchip Technology Inc. User Guide DS50003015A-page 6
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........... continued
Pin on ATSAMR30M m Shared Functionality
PAO7 Alert J2 pin 2

CryptoAuthentication Device

The ATSAMR30M Sensor Board has a footprint provision for evaluating the Microchip ATECC608A
CryptoAuthentication IC. The following table lists the interfaces between the CryptoAuthentication IC and the
ATSAMR30M.

Table 3-4. CryptoAuthentication Device Functions

Pin on ATSAMR30M m Shared Functionalty

PAO8 I12C Serial Data (12C SDA) Temperature sensor and J2 pin 6

PA09 I12C Serial Clock (12C SCL) Temperature sensor and J2 pin 5

Headers and Receptacles
The following headers and receptacles are supported by the ATSAMR30M Sensor Board.

mikroBUS Compatible Clicker Receptacles

The mikroBUS Clicker Board is an evaluation platform that provides an easy extension to many applications. This
platform consists of a series of Click Boards that are easily pluggable with the ATSAMR30M Sensor Clicker Board.
The mikroBUS Click Boards support a wide range of different applications. These Click Boards are connected
through a set of standardized headers and receptacles. All mikroBUS Clicker Boards contain two single row, 8-pin,
100-mil receptacles. The Clicker Boards have female connectors, while Click Boards have their male counterparts.

Note: All pins are not always connected. The Clicker receptacles can be used to connect a variety of Click Boards
or to access the pins of the target MCU on the Clicker Board directly.

The mikroBUS Clicker Board receptacles (J1 and J2) provide the interface to use the ATSAMR30M Sensor Board.
The following tables provide the pin details of these receptacles, respectively.

Table 3-5. Receptacle (J1) Pin Details

MB_AN PAO06 AIN[6]; ADC pin
2 MB_RST PA15 GPIO; can be used to reset the connected Click
Board
3 MB_CS PA17 SERCOMA1/PADI[1]; slave select for SPI
4 MB_SCK PA19 SERCOM1/PADI3]; clock for SPI
5 MB_MISO PA16 SERCOM1/PAD[0]; MISO line of SPI
6 MB_MOSI PA18 SERCOM1/PAD[2]; MOSI line of SPI
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Hardware Specifications

........... continued

VCC_3V3 3.3V power supply

» To power the connected Click Boards when
the ATSAMR30M Sensor Board is supplied
by battery or external supply in the LDO
Selection mode.

+ To power the ATSAMR30M Sensor Board
from a connected Click Board like the FTDI
Click Board, which has its own power
source.

8 GND GND Ground

Table 3-6. Receptacle (J2) Pin Details

Pin on J2 Pin on ATSAMR30M Description Shared
Functionality

MB_PWM | PA14 PWM output

2 MB_INT PAO7 Hardware input interrupt —

3 MB_RX PA25 SERCOMS3 PAD[3]; UART RX of the | —
ATSAMR30M

4 MB_TX PA24 SERCOMS3 PAD[2]; UART TX of the —
ATSAMR30M

5 MB_SCL PAO9 SERCOMO/PADI[1]; I2C Serial Clock | Temperature sensor
Line (SCL) for the bus clock and ATECC608A

6 MB_SDA PA08 SERCOMO/PADI0]; I12C Serial Data Temperature sensor
Line (SDA) for data transfer and ATECC608A

7 NC — Not connected —

8 GND GND Ground —

Serial Wire Debug Header

The SWD header (J3) is on-board for programming and debugging the ATSAMR30M18A module. The pinout of this
header is compatible to interface with the SAM port of Atmel-ICE or SAM-ICE using the ATATMEL-ICE-ADPT
accessory kit. The following table lists the pin details of the SWD header.

Table 3-7. SWD Header

1 VCC

2 SWDIO

3 GND

4 SWDCLK
5 GND

6 NC

© 2020 Microchip Technology Inc. User Guide DS50003015A-page 8
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3.6.4
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Hardware Specifications

........... continued

7 NC

8 NC

9 GND
10 RESET

LDO Selection/Bypass Header

The ATSAMR30M Sensor Board operates with supply voltage ranging from 1.8V(") to 3.63V. Low Dropout Regulator
(LDO) selection/bypass header (J4) is used to select/bypass the LDO based on the need for 3.3V supply.

Jumper positions for the following modes of power supply:
+  LDO Bypass mode(® — Place the jumper cap between pins (1 and 2) of J4
+ LDO Selection mode(® — Place the jumper caps between pins (1 and 3) and pins (2 and 4) of J4 as shown in
Figure 2-1.
Notes:
1. If the CryptoAuthentication™ device (ATECC608A) is mounted on the board, the minimum supply voltage
required to operate it is 2V.
2. LDO Bypass mode can be used to avoid LDO current consumption for extending the battery life. This is the
preferred mode if the ATSAMR30M Sensor Board is supplied with a 3V battery or 3.3V from a Click Board
(FTDI Click Board).
3. LDO Selection mode can be used if the ATSAMR30M Sensor Board supplies power to the connected Click
Board, which needs 3.3V to operate.

External Supply Header
The standard bench power supply provides power to the external supply header (J5), to evaluate the operating
voltage range (1.8V — 3.6V). LDO Bypass mode must be used to test the supply voltage range.

Note: With no power multiplexer on-board, connect either a battery or an external supply or an FTDI Click Board to
power up the ATSAMR30M Sensor Board.

© 2020 Microchip Technology Inc. User Guide DS50003015A-page 9
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Getting Started

This chapter provides the prerequisites to start the evaluation with the ATSAMR30M Sensor Board. The sensor board
is factory programmed with the Performance Analyzer application firmware. Users with a new board from the factory
must follow instructions given in Section 4.1 Setup for Standalone Operation and Section 4.2.2 Programming
Wireless Assembly Using Atmel Studio 7.0 (skip Step 7 and 8) for setup. Refer to Section 4.2.1 Installing Wireless
Composer 7.0 Extension in Atmel Studio 7.0 to install the wireless composer and to get started with Performance
Analyzer GUI.

Setup for Standalone Operation

The ATSAMR30M Sensor Board supports the Standalone mode with an external programmer/debugger (Atmel-ICE
or SAM-ICE™) and a UART-USB converter (like FTDI Cable) interfaced to UART pins of J2 for evaluation. To supply
power, connect the board with either a 3V coin cell battery or a 3.3V through J5 header (external supply).

The setup shown in the following figure consists of a jumper configuration for the LDO Selection mode. To power the
module across the operating voltage range of 1.8V to 3.63V, the jumpers must be in LDO Bypass mode.

Note: Refer to Section 3.6.3 LDO Selection/Bypass Header for more details.

Figure 4-1. Sensor Board Setup with External Programmer/Debugger, UART-USB Converter and External
Supply

ATSAMR30M Sensor Board and mikroBUS Click Board Interface

The receptacles (J1 and J2) provide the interface to use the ATSAMR30M Sensor Board with a Click Board. The
connection of the sensor board with an FTDI Click Board is shown in the following figure. Similarly, the sensor board
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can also be connected with a Click Board that has different functionality to demonstrate applications based on
customer requirements.

The ATSAMR30M sensor board interfaced with the FTDI Click Board could be used as an alternate to the setup
shown in Figure 4-1. The FTDI Click Board could power the ATSAMR30M sensor board and act as the UART-USB
Converter. This setup can only be operated at 3.3V as the FTDI Click Board is the power source.

Figure 4-2. ATSAMR30M Sensor Board and mikroBus FTDI Click Board Connection
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mikroBUS FTDI Click Board ATSAMR30M Sensor Board

Performance Analyzer

The Performance Analyzer firmware with a GUI (Wireless Composer Extension) in Atmel Studio provides a way to
perform a number of basic RF functional tests. A quick-start guide and general help are available in the starting page
of the Performance Analyzer window of the Atmel Studio. The latest version of Atmel Studio is 7.0.

This section guides the user to install the necessary wireless extension and to program the wireless assembly using
Atmel Studio 7.0.

Installing Wireless Composer 7.0 Extension in Atmel Studio 7.0
The following steps explain how to install the necessary wireless extension tool in Atmel Studio 7.0.

1. Install and open Atmel Studio.
2. Go to the Tools menu and click Extensions and Updates....

© 2020 Microchip Technology Inc. User Guide DS50003015A-page 11
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Figure 4-3. Extensions and Updates Menu Option

Tools

ml TR

=
(L 1]

0

| Window Help
Command Prompt
Device Pack Manager
Device Programming
Add target...

Data Visualizer

Code Snippets Manager...
Extensions and Updates...
Atmel Gallery Profile...
External Tools...

Import and Export Settings...
Customize...

Options...

Ctrl+Shift+P

Ctrl+ K, Ctrl+B

3. Inthe Extensions and Updates window, click Available Downloads.

>

Expand All options on the left navigation pane and click Wireless.

5. Select Wireless Composer 7.0 and click Download, which directs to Microchip Gallery.
Figure 4-4. Extensions and Updates Window

Extensions and U

v Installed

4 Available Downloads

—

Sort by: | Highest Ranked -

| % Arduino IDE for Atmel Studio

\ For Arduno 166 and Atmel Studio 7.0 please

6.

Change your Extensions and Updates settings

‘A" i download from www.visuaimicro.com or click “More...
I Debugging Wireless Composer 7.0
Development Provides the Wireless Performance Analyzer and IEEE
b Device 802:15.4 MAC Project Wizard. Wireless Performance A...
I Projects ] .
= Wireless Performance Analyzer Firmware
b Toolchain =z b -
= Provides Wireless Performance Analyzer firmware files
b Tocls (hex, srec) used to demonstrate various features and...
b Training
b Utilities + || Atmel SerialNet
Verification | AT-command interface for wireless mesh-networking
Wirchss on Atmel 802.15.4 devices.
Updates (2)

A standzlone, serial boot loader utility for use with
Atmel wireless software stacks such as BitCloud, RF4...

Avazilable Downloads

Created by: Atmel
Version: 7.0.83
Downloads: 428
Rating: deskrirde

Reviews

ik

Anton Zabolotney
12/12/2015 Version: 7.0.82
ik

Veena KB

11/19/2015 Version: 7.0.82

4| Atmel AVR2054 Serial and OTA Bootloader

(Cul-) P~

Close

Log in to the Microchip Gallery with a myMicrochip account.
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7.

8.

9.

Figure 4-5. Microchip Gallery Dashboard

S
A sign in to Atmel Gallery Dashboard

A\ MicrocHIP

Why register for myMicrochip?
Join myMicrochip and gain access to member-only benefits with new
features added constantly. Take advantage of these great perks by
joining today!

We have now integrated your myAtmel account to myMicrochip
and microchipDIRECT. To verify your account access, simply reset
your password if you have not already and then log in to
myMicrochip or microchipDIRECT.

myMicrochip Benefits Include:

©

Signin

Free Technical Free Samples Access to Product Change
Support microchipDIRECT  Notification Delivery
I Inventory

Favorite Products and
Documents Saved to
Profile

)

Easy Registration for
Your Software and Tools

New Product Updates

OO0

Search for Wireless Composer in the search bar and click the latest version.

Figure 4-6.

Wireless Composer Page

r -
[ Sign in to Atmel Gallery Dashboard

T

Home

3,469

Downloads

3,469

Downloads of v 7.0.130

2017-12-22

Last published

Contact Owners
Report Abuse
Download

Open in Package Explorer

I A\ MicrocHIP Q

arunkarthik.mariappan / Sign out

Upload Extension

Wireless Composer 7.0 7.0.130

Provides the Wireless Performance Analyzer and IEEE 802.15.4 MAC Project Wizard. Wireless Performance Analyzer
is used to demonstrate various features and capabilities of Atmel IEEE 802.15.4 Transceivers and BLE Transceivers.
IEEE 802.15.4 MAC Project Wizard provides user interface to create firmware projects based on AVR2025 MAC stack
using Atmel microcontrollers and IEEE 802.15.4 transceivers.

Prerequisites:
- Atmel Studio 7.0.934 or later
- Atmel Software Framework v3.31.0435 or later

- Performance analyzer Firmware available in the package "Wireless Performance Analyzer Firmware” (download
from Atmel Gallery)

- Performance analyzer Firmware Source code available in ASF v3.31.0.435 or later (download from Atmel Gallery)

To install Wireless Composer 7.0, download this extension and open it. It should install into Atmel Studio. Please
make sure you have the necessary version of Atmel Studio installed in your PC.

Supported Products: Atmel Studio 7.0

Owners

H Microchip

Authors
Atmel

Tanc

On the webpage of the extension, click Download and, when prompted for file download, click Open. The
extension automatically installs after completion of the download.

Install Wireless Composer.
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Figure 4-7. VSIX Installer

& vsIX Installer ﬁ]

Wireless Composer 7.0

Select the product(s) you want to install the extension to:
¥ AtmelStudio

This extension does not contain a digital signature.

Copyright (c) 2011 Atmel Corporation. All rights reserved. =

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are

met:

By clicking "Install”, you agree with the

above license terms (if any). Install

H Cancel |

%

10. Restart Atmel Studio after the installation. The Performance Analyzer GUI will be available in the Tools menu.

Figure 4-8. Performance Analyzer Menu Option
Tools | Window Help
B Command Prompt
@ Device Pack Manager

:ﬁ Add target...
. Data Visualizer
@

Bluetooth Low Energy Performance Analyzer

Performance Analyzer

v Device Programming Ctrl+Shift+P

[.]  Code Snippets Manager... Ctrl+K, Ctrl+B

[l] Extensions and Updates...
Atmel Gallery Profile...
External Tools...

Import and Export Settings...
Customize...
£} Options...

Programming Wireless Assembly Using Atmel Studio 7.0

The following steps explain how to program the ATSAMR30M Sensor Board and get started with the Performance

Analyzer application.

1. Power up the board with a battery or external supply and connect a generic USB-UART converter to the UART
pins of the sensor board. Otherwise, use an FTDI Click Board(") for powering up® and enabling UART

communication with the Sensor Board.

Notes:

1. The resistors (J1, J2, J3) mounted in the position indicated by 12C need to be removed and
assembled in the UART position as shown in the following figure.

2. Do not use the FTDI Click Board for the UART connection if the sensor board is powered from an

external supply voltage other than 3.3V. When required to evaluate at voltage levels other than 3.3V,

use the setup described in Figure 4-1.
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Figure 4-9. Resistor Jumpers' Placement for FTDI Click Board in UART Mode

g g
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I | z:)e mel X1

Open Atmel Studio.
Navigate to the menu File > New > Example Project.
Select SAMR30 from the Device Family drop-down list.

Enter Performance analyzer in the "Search for Example Projects" field. Select "Performance Analyzer
Application AT86RF212B - SAM R30 Module Xplained Pro" to create an example project under the selected
directory.

ok wbd

Figure 4-10. Selecting Performance Analyzer Application

—
Device Family: [SAMRSD ~ | Category: [AII -l Performance analyzer
' Projects | Atmel - QTouch Library (0) [ 109 =

it
TrETE | Atmel - QTouch Library (0) | 107 ~ I
Technology 4 7] Atmel - Atmel Corp. (2) | 3.42.0 vI
Addon | (5| Performance Analyzer Application ATB6RF2128 - SAM R30 module Xplained Pro |

4| Performance Analyzer Application ATS0RF2128 (ATZB—ZIZB—XWO) - SAM R30 Xplained Pro

Project Name: ASFProject

I Location: FAWOrk\SAMR30_XPROXPROVSVN\O7 Firmware\Production Selfrest firmware

Solution: [Add to Solution i

Solution name:  ASFProject

Device: No Device

6. After the project solution is successfully opened, initiate the build by clicking 'Build solution' from the Build
menu.

7. Connect an external debugger, like Atmel-ICE, to the ATSAMR30M Sensor Board. Ensure that the pin 1 of the
cable (indicated by red wire) is interfaced to the SWD header, as shown in the following figure.
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Figure 4-11. Connecting Programmer/Debugger with ATSAMR30M Sensor Board

8.  After successful build completion, open the Device Programming window from the Tools menu.
9. In the Device Programming window, set the following:
— Tool — Atmel-ICE
— Device — ATSAMR30E18A
— Interface — SWD
10. Click Read to read the device signature and target voltage. If there are issues in reading the signature or
target voltage, ensure that the programming cable is firmly connected to the SWD header.
11. Navigate to the Memories tab and click Program.
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Figure 4-12. Device Programming
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12. Open the Performance Analyzer from the Tools menu in Atmel Studio.
13. Follow the Quick Start guidelines available in the starting page of the Performance Analyzer window.
14. Select COM port of the UART-USB converter and click Connect. The Performance Analyzer connects with the

ATSAMR30M Sensor Board. When using the FTDI Click Board as a UART-USB converter, the FTDI Click

Board enumerates as Two COM ports. Use the port with lower COM number for interfacing with the
Performance analyzer GUI.

© 2020 Microchip Technology Inc. User Guide DS50003015A-page 17



ATSAMR30M
Getting Started

Note: The Performance Analyzer allows setting or changing of the parameters like Channel Page, Channel, TX
Power Register Value and so on, to perform various RF tests. For more details about the use of the Performance

Analyzer, click the help icon as shown in the following figure.
Figure 4-13. Performance Analyzer - Help
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Regulatory Approval

This equipment (ATSAMR30M Sensor Board/DT100130) is an evaluation kit and not a finished product. It is intended
for laboratory evaluation purposes only. It is not directly marketed or sold to the general public through retail; it is only
sold through authorized distributors or through Microchip. Using this requires engineering expertise towards
understanding of the tools and relevant technology, which can be expected only from a person who is professionally
trained in the technology.

When this module is used in USA/Canada, the user must restrict the operating frequency band within 902-928 MHz.
For Europe, the user must ensure that the module is operated only within the 868-868.6 MHz frequency band.
Regulatory compliance settings have to follow the ATSAMR30M18A module certifications.

The following regulatory notices are to cover the requirements under the regulatory approval.

United States

The ATSAMR30M Sensor Board (DT100130) contains the ATSAMR30M18A module, which has received Federal
Communications Commission (FCC) CFR47 Telecommunications, Part 15 Subpart C “Intentional Radiators” single-
modular approval in accordance with Part 15.212 Modular Transmitter approval.

Contains Transmitter Module FCC ID: 2ADHKR30M

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Important: FCC Radiation Exposure Statement

This equipment complies with FCC radiation exposure limits set forth for uncontrolled environment. The
antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm
from all persons and must not be co-located or operating in conjunction with any other antenna or
transmitter. This transmitter is restricted for use with the specific antenna(s) tested in this application for
certification.

Any changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate this equipment.

A\ CAUTION

FCC Notice
This kit is designed to allow:

» Product developers to evaluate electronic components, circuitry or software associated with the kit to determine
whether to incorporate such items in a finished product.

» Software developers to write software applications for use with the end product. This kit is not a finished product
and when assembled may not be resold or otherwise marketed unless all required FCC equipment
authorizations are first obtained. Operation is subject to the condition that this product not cause harmful
interference to licensed radio stations and that this product accept harmful interference. Unless the assembled
kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must operate
under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this
chapter.

» The kit is for evaluation only; not FCC approved for resale; and any radio frequency transmitter employed as
part of an evaluation kit shall be designed to comply with all applicable FCC technical rules, including frequency
use, spurious and out-of-band emission limits and maximum power or field strength ratings applicable to final
products that would employ the components or circuitry to be evaluated.
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* Under 47 CFR 2.805(d)(2), in order to operate the evaluation kit, the user must ultimately render the device
inoperable or return it to Microchip.

« Evaluation kit is defined by FCC as “[a]n assembly of components, subassemblies, or circuitry, including
software, created by or for a component maker, system integrator, or product developer for the sole purpose of
facilitating: End product developer evaluation of all or some of such components, subassemblies, or circuitry, or
(i) the development of software to be used in an end product.” (see 47 CFR 2.1)

Canada

The ATSAMR30M Sensor Board (DT100130) contains the ATSAMR30M18A module, which has been certified for
use in Canada under Innovation, Science and Economic Development Canada (ISED, formerly Industry Canada)
Radio Standards Procedure (RSP) RSP-100, Radio Standards Specification (RSS) RSS-Gen and RSS-247.

Contains IC: 20266-R30M

This device contains license-exempt transmitter(s)/receiver(s) that comply with Innovation, Science and Economic
Development Canada'’s license-exempt RSS(s). Operation is subject to the following two conditions:

1. This device may not cause interference;

2. This device must accept any interference, including interference that may cause undesired operation of the
device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux CNR d’Innovation,
Sciences et Développement économique Canada applicables aux appareils radio exempts de licence. L’exploitation
est autorisée aux deux conditions suivantes:
1. Lappareil ne doit pas produire de brouillage;
2. Lappareil doit accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d’en
compromettre le fonctionnement.

/AN\WARNING

This equipment complies with radio frequency exposure limits set forth by Innovation, Science and
Economic Development Canada for an uncontrolled environment. This equipment must be installed and
operated with a minimum distance of 20 cm between the device and the user or bystanders.

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par d’'Innovation,
Sciences et Développement économique Canada pour un environnement non contrélé. Cet équipement
doit étre installé et utilisé avec un minimum de 20cm de distance entre le dispositif et |'utilisateur ou des
tiers.

The following table provides the specification of the integrated PCB antenna on the ATSAMR30M Sensor Board.
Table 5-1. PCB Antenna Specifications

Peak gain 0.44 dBi
Operating frequency 868- 928 MHz
Europe

This equipment (DT100130) has been assessed under the Radio Equipment Directive (RED) for use in European
Union countries. The product does not exceed the specified power ratings, antenna specifications and/or installation
requirements as specified in the user manual. A Declaration of Conformity is issued for each of these standards and
kept on file as described in RED.

Simplified EU Declaration of Conformity
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Hereby, Microchip Technology Inc. declares that the radio equipment type [DT100130] is in compliance with Directive
2014/53/EU.

The full text of the EU declaration of conformity is available at (refer product specific pages): www.microchip.com/
design-centers/wireless-connectivity/.
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The Microchip Website

Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

* Product Support — Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

* Business of Microchip — Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service

Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

» Distributor or Representative

* Local Sales Office

» Embedded Solutions Engineer (ESE)
» Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

» Microchip products meet the specifications contained in their particular Microchip Data Sheet.

» Microchip believes that its family of products is secure when used in the intended manner and under normal
conditions.

* There are dishonest and possibly illegal methods being used in attempts to breach the code protection features
of the Microchip devices. We believe that these methods require using the Microchip products in a manner
outside the operating specifications contained in Microchip’s Data Sheets. Attempts to breach these code
protection features, most likely, cannot be accomplished without violating Microchip’s intellectual property rights.

» Microchip is willing to work with any customer who is concerned about the integrity of its code.

» Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable.” Code protection is constantly
evolving. We at Microchip are committed to continuously improving the code protection features of our products.
Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act.
If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue
for relief under that Act.
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Legal Notice

Information contained in this publication is provided for the sole purpose of designing with and using Microchip
products. Information regarding device applications and the like is provided only for your convenience and may be
superseded by updates. It is your responsibility to ensure that your application meets with your specifications.

THIS INFORMATION IS PROVIDED BY MICROCHIP “AS 1S”. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR
OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR
CONSEQUENTIAL LOSS, DAMAGE, COST OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk,
and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or
expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox,
KeelLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo, MOST,
MOST logo, MPLAB, OptoLyzer, PackeTime, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip Designer,
QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer, Tachyon,
TempTrackr, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, FlashTec, Hyper Speed Control,
HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC, ProASIC Plus,
ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra, TimeProvider,
Vite, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, Anyln, AnyOut, BlueSky, BodyCom,
CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController, dsPICDEM,
dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, EtherGREEN, In-Circuit Serial Programming, ICSP,
INICnet, Inter-Chip Connectivity, JitterBlocker, KleerNet, KleerNet logo, memBrain, Mindi, MiWi, MPASM, MPF,
MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach, Omniscient Code Generation, PICDEM,
PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE, Ripple Blocker, SAM-ICE, Serial Quad
I/0, SMART-I.S., SQlI, SuperSwitcher, SuperSwitcher I, Total Endurance, TSHARC, USBCheck, VariSense,
ViewSpan, WiperLock, Wireless DNA, and ZENA are trademarks of Microchip Technology Incorporated in the U.S.A.
and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany Il GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2020, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.
ISBN: 978-1-5224-6454-9
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Quality Management System

For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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